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BILLION 
MARKET 

the College Store industry
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NACS MEDIA PLANNER	 COMPREHENSIVE SOLUTIONS

COMPREHENSIVE SOLUTIONS  
FOR ACCESS TO COLLEGIATE RETAILING

THE RIGHT EXPOSURE 		
Make every marketing dollar count by  
connecting with the right audience.

• Print and Electronic Media
• Advertising
• Sponsorships
• Industry Leading Buying Show
• Charitable Opportunities

THE RIGHT CONTACTS
We know people. And we want  
to introduce you.

• Mailing Lists
• Networking Opportunities
• College Store Managers
• Category Buyers

THE RIGHT KNOWLEDGE
We know what you need to know.

• Consumer Insight
• Student Feedback
• Focus Groups & Student Surveys
• Webinars, Seminars & Podcasts

THE RIGHT RESOURCES	
NACS offers support through  
every step of the sales process.  

• Individualized Consulting
• Sales Agents
• Specialized Education
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NACS MEDIA PLANNER	 CIRCULATION & DISTRIBUTION

THE FIRST CHOICE 
FOR COLLEGIATE RETAILERS

The official publication of NACS, The College 

Store is the leading trade magazine for 

higher education retailers. Designed to help 

collegiate retailers enhance the services 

they offer, The College Store is also uniquely 

positioned to provide exposure for publishers 

and manufacturers whose products are 

merchandised within the stores. Reaching every 

collegiate retailer in North America, including 

key buyers and decision makers, The College 

Store is the only magazine that gives you direct 

access to the college market.

Source: The 2015 NACS Member Survey

CIRCULATION

10,000+
FREQUENCY

Published 6 times 
per year

Point buyers in the 
right direction.

84% 83%
of store directors/managers 

say they consistently get 
helpful information related 

to their jobs

of store directors/
managers read  

The College Store 
“often” or “always.”

25% 57% 65%
contacted an  

advertiser directly  
for information

suggested the store 
carry a mentioned 
product/service

ordered a 
product/service

The only magazine that  
gives you direct access to  

the college market. 

As the result of reading ANY NACS publication, 
store directors/managers have taken these actions:



NACS MEDIA PLANNER	 EDITORIAL CALENDAR
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JANUARY/FEBRUARY	 • Holding in-store events to draw traffic	 CAMEX Preview Guide #2

Close Date: Nov. 29, 2019	 • Getting involved with brand activations	 CAMEX Exhibitor Directory

Artwork Due: Dec. 6, 2019	 • The value of obtaining an MBA	 CAMEX Sessions Map

		  • CAMEX 2020: Where to dine in New Orleans	 Downtown New Orleans Map

		  • Course materials strategies for stores	

		  • Index of 2019 content (in digital edition only)

 

MARCH/APRIL	 • Meet new NACS President Steven Westenbroek	

Close Date: Jan. 24, 2020	 • Ideas for merchandising access codes	

Artwork Due: Feb. 3, 2020	 • Who’s shopping your e-commerce site?

		  • What to do when general merchandise doesn’t sell

		  • Making the most of online marketplaces

 

MAY/JUNE	 • Great Ideas from CAMEX 2020	 Eye On CAMEX Top Choices	

Close Date: Mar. 27, 2020	 • CAMEX 2020 in photos	

Artwork Due: April 3, 2020	 • What’s new with inclusive access

		  • What administrators need to know about your store

		  • Partnering with vendors 

		     for store-within-a-store sales

		  • NACS 2019-20 Volunteer Honor Roll

 

JULY/AUGUST	 • Building career skills into student employee duties	 Eye On Back to Campus	

Close Date: May 22, 2020	 • Selling health and fitness products	

Artwork Due: June 5, 2020	 • Serving as the campus textbook hub without stock

		  • Adding humor to store displays

		  • Collegiate licensing

 

SEPTEMBER/OCTOBER	 • 15th Annual Store Design Showcase	 CAMEX Preview Guide	

Close Date: July 31, 2020	 • Products you might not have thought to sell	

Artwork Due: Aug. 7, 2020	 • Dealing with course materials piracy

		  • How to stop driving your customers crazy

		  • Determining the right staffing for your store

 

NOVEMBER/DECEMBER	 • 33rd Annual Fashion Focus	 Eye On CAMEX Product Preview

Close Date: Sept. 25, 2020	 • The latest on collegiate fashion trends	 CAMEX Preview Guide

Artwork Due: Oct. 2, 2020	 • �CAMEX 2021: What to see and do in Atlanta	 Fashion Focus Buyers’ Guide

		  • Should your store go cashless?

		  • Open educational resources update 

		     and opportunities

  FEATURED TOPICS	 EXTRAS
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NACS MEDIA PLANNER	 PRINT ADVERTISING RATES

FOUR COLOR 1X 2-3X 4-5X

Full Page $2,800 $2,500 $2,250

1/2 Page Island $2,350 $2,100 $1,800

1/2 Page  $2,200 $1,950 $1,700

1/3 Page $1,950 $1,700 $1,500

1/4 Page $1,400 $1,200 $1,000

Special Feature /Guide $750 $450 N/A

MULTIPLE RATE APPLICATION

Multiple rates apply to advertising space reserved in advance for a  
12-month period. Charges will be readjusted with changes in frequency.

ADDITIONAL COLORS
$600 matched  $500 standard AAAA

Ask about other combination rates.

COVERS
All covers are four-color.

Back cover  full page rate plus $525

Inside front cover  full page rate plus $475

Inside back cover  full page rate plus $420

SPECIAL POSITIONS
Special positioning reserved for four-
color ads only.

Page 1  full page rate plus $395

Page 3  full page rate plus $315

Special placement  full page rate plus $315

Sequential pages  add $160 per page after first page

*All rates are price per ad placement.

 30% additional charge for non-vendor affiliates.
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NACS MEDIA PLANNER	 SPECIALTY ADVERTISING

FALSE COVER

The College Store magazine will place your full-page advertsement 
as a cover over our front cover. Your ad must include the magazine’s 
masthead and be approved through our office

Size: 8.25” x 10.625”

Rate*: 2-sided: $4,500

Printing: Price includes printing.

INSERT

The College Store magazine will bind an advertiser’s preprinted  
2-sided insert into the publication.

Size: 8.75” x 11.25”

Insert will be trimmed 1/8” (.125) on all four sides. Keep live copy  
at least 5/16” (.3125”) away from trim edges and gutter.

Weight: Not to exceed 100 lb. book stock or 110 lb. index stock.

Rate*: 2 pages: $3,500

Printing: Advertiser may supply preprinted piece.

CATALOGS

Have a thin, preprinted catalog that can be gummed into The College 
Store magazine? Then this is the perfect option. A gummed-in item  
can be safely and easily removed from the publication.

Size: 8.0” x 10.625”

Weight: Not to exceed 16 pages on 50 lb. text stock, 2.7 oz.

Rate*: $4,500

Printing: Advertiser may supply preprinted piece.

ADVERTORIAL (2 PAGE SPREAD)

Your opportunity to tell your story to a readship of 
10,000+. Advertorials educate and entertain readers,  
as well as promote a product or service. Content  
must be approved through our office.

Size: 17.25” x 11.125” bleed size

Rate*: 2 pages: $3,200

QuickStudy Notebooks

QuickStudy Folders

LEARN QUICK. LEARN SMART. Free Shipping on any new products orders over 
$800.00. Expires 5/31/17. Use Code: NACS2017

• 95% Pure Oxygen Supplement. 
• Natural Energy and Recovery from 

the effects of stress, long drives,  
exercise, travel and altitude.

• Greater value than energy drinks!
• Available in 0+ Mini ($4.99 SRP) and  

0+ Skinni ($5.99 SRP).

College ruled, one-subject notebooks with perforated pages for easy removal. Inside cover, dividing insert page and back 
cover pages have QuickStudy® content for studying, homework, in-class answers and overall better grades.  SRP $4.99

Two pocket folders have QuickStudy® content for studying, homework, in-class answers, and overall better grades on the 
cover, inside pocket fronts, and back cover. SRP $2.49

NEW PRODUCTS FOR

Order a case pack of 24 for only $71.76. 

Order a case pack of 48 for only $59.52. 

Order a Mini 
case pack of 72 
for only $235.44.

Order a Skinni case pack of 48 for only $185.76.

Four subjects with 
study notes built in. 

Four subjects with 
study notes built in. 

Order Toll Free: 1-800-226-7799 or email customerservice@barcharts.com

SAVE!

BETTER GRADES

3 TRENDS
IMPACTING CAMPUS
STORES IN 2019
There are three major trends 
dominating Campus Bookstores in 
2019. Course material affordability 
continues to drive transformation 
of stores across the nation. Student 
choices for affordable course materials 
sourced through alternate channels 
continue to cause declines in store 
revenue. The second trend is to 
compensate for the loss of course 
material revenue by the expansion of 
the merchandise portion of the retail 
business. Finally, competing for sales 
with the likes of Amazon, Football 
Fanatics, and Cheeg is causing the 
third trend. Campus Bookstores are 
compelled to rapidly adopt world class 
omnichannel retail technology and 
practices or face extinction.

Increasing government 
regulation and students’ 
pragmatic quest for course 
material affordability is forcing 
the implementation and 
expansion of Inclusive 
Access offerings.

Sales of digital course materials, 
rentals and used books continue 
to displace the once lucrative new 
book sale business. Sales and 
margins for course materials have 
continued to decline to the point that 
course materials might make up less 
than 15% of a Campus Bookstore’s 
total revenue. Simultaneously, the 
complexity of managing Inclusive 
Access, selling and fulfilling the 
various forms of course materials 
through both POS and website has 
obsoleted many legacy systems.

www.netsuite.com/campus-stores

 
ADVERTORIAL

The NetSuite Campus Store Edition is the world class 
Omnichannel Cloud Retail Management System and 
Delivery for Campus Bookstores designed to support the 
most recent trends in campus retail. 

The second trend is to 
compensate for the loss of 
course material revenue by 
the expansion of the retail 
merchandise portion of 
the business.

Logo apparel and merchandise, trade 
books, candy and other offerings 
are now dominating the retail floor 
space once reserved for books. This 
expansion and the management 
of the corresponding number of 
SKUs requires a modernization of 
the retail operation especially in the 
areas of order management, vendor 
EDI integration, and advanced 
warehouse management. The required 
functionality and integrations could 
take months, years, or even be 
impossible with some legacy systems.

Finally, the bookstore’s 
customers expect a modern 
retail experience. 

Today’s students can’t even 
remember the time before cell phones 
and Amazon. Buy Online Pickup In 
Store (BOPIS) and the corresponding 
Buy Online Return In Store (BORIS) 
are no longer optional. Students 
must be able to purchase or rent 
course materials online and pickup 
at the Campus Bookstore. Optimally 
the student should be able to opt-
in or opt-out of Inclusive Access on 
the website from their cell phone 
and have the appropriate materials 
delivered electronically, ready for 
pickup at the bookstore, or even 
delivered directly to their dorm room.

With thousands of customers in 
the retail industry, we have deep 
experience working with companies 
like yours. NetSuite has taken this 
industry expertise and adapted it to 
meet the unique business challenges 
of the campus bookstore. An 
exhaustive list of campus bookstore 
required features and enhancements 
have been integrated into the 

Campus Store Edition. Combine these 
features and this industry expertise, 
optional third-party integrations, and 
the leading practices developed by 
our dedicated campus bookstore 
professional services team, we 
help our customers transform their 
businesses to develop competitive 
advantage in the marketplace.

*30% additional charge for non-vendor affiliates.

The Official Publication Of The National Association Of College Stores

MARCH | APRIL 2019

Leading-Edge

digital course materials.

Delivered Effortlessly.  

See reverse to learn more.

As the most utilized Inclusive Access platform among 

independent bookstores, RedShelf is making our 

industry’s digital evolution far less daunting.

SPECIALTY  
ADVERTISING OPTIONS

Create a buzz and draw attention 
to your advertisement.

The College Store
CIRCULATION

10,000+
FREQUENCY

6x per yr.
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NACS MEDIA PLANNER	 DIGITAL MAGAZINE OPPORTUNITIES

SLIDESHOW
Image assets can be uploaded into a slideshow in the digital 
edition of The College Store magazine. Customizable options 
include looping, auto-start, seconds per slide and whether 
the slideshow pops up or is embedded

Specs: 

• �The slide show format is JPG and images should be the 
same size.

• �Recommended: Include slideshow indicators on the  
PDF page  

AUDIO AND VIDEO 
Video options include embedded auto-start or click-to-start 
pop-up videos within the digital; or links to external videos that 
open in another window, leaving the digital edition open in the 
background for the reader to navigate back to. 

Specs: Embedded Video
• The video format required is MP4
• �The recommended bit-rate is between 300kb/s and 700kb/s. 
• �The recommended height is 600 pixels or smaller to fit most 

screens. (1024x600 or smaller)
• �File size must be less than 100 mb, and have a play length 

of 1 second or more.
• �Recommended: include video indicators on the PDF page 

Specs: Links to external video
• URL to external video
• �Recommended: include video indicators on the PDF page

Call for Digital Advertisement Prices

DIGITAL MAGAZINE OPPORTUNITIES
Extend your reach to thousands of visitors

Click icon to  
view pop-up  

video

SLIDESHOW

VIDEO
Embedded 
auto-start
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NACS MEDIA PLANNER	 DIGITAL MAGAZINE OPPORTUNITIES

MARGIN ADS
Banner and skyscraper ads can be set for an issue or 
page. Margin ads are supported for desktop viewing but 
do not display in mobile browsers due to the screen and 
navigation constraints.  

NOTE: Margin ads ONLY appear when viewed on a 
computer; they DO NOT appear when viewed on a 
phone or tablet.
Margin Ads appear in a space outside the page (right, 
left, top, or bottom), and multiple (same size) ads can 
rotate within the same space.

Specs: Provide URL and Image (sizes below)
Image: PNG, GIF, JPG, or SWF animation  
(width x height in pixels)

Horizontal 728x90 (Full ad)
Vertical 120x600 (Vertical Skyscraper)
Wide Vertical 160x600 (Vertical Wide Skyscraper)

Call for Digital Advertisement Prices

DIGITAL MAGAZINE OPPORTUNITIES CONT’D.

TICKERAximo ommo omnihiliquas rem aut facculpaquoomhic                                         onsectur, connos ommo omnihiliquas rem aut faccul

HORIZONTAL BANNER AD
728px x 90px
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Put your brand 
front and center for 
better recognition!

TICKER

MARGIN  
ADS

MARGIN  
ADS

TICKER
The Ticker displays clickable text and/or a small image 
at the bottom of every page (1 at a time per publication). 
Direct readers to your website, event or subscription 
page.

Specs: Provide text and URL Address; Optional image is 
up to 500 pixels wide x 20 pixels high; PNG, RGB.
Note: Limited space.
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NACS MEDIA PLANNER	 MANUFACTURING & DOCUMENT LAYOUT SPECIFICATIONS

SOFTWARE APPLICATIONS
•	 QuarkXPress
•	 InDesign
•	 Illustrator (flattened layers)
•	 Photoshop (flattened layers)

High-resolution PDFs are preferred for file submission. However, if 
sending application files, include all supporting graphics and fonts.

PAGE CONSTRUCTION
•	 Page Size of the document must be the same  

as the final trim size: 8.5" x 10.875"
•	 Bleed must be at least 0.125" (or p9) past the  

trim line. Full-bleed ads are no extra charge.
•	 Crop and Registration Marks must be offset  

by at least 0.125" (or p9) from the trim line. 

Crop and registration marks CANNOT be in the bleed area.

•	 Safety Margin Text or images can be no closer than  
0.1875" to the trim line.

•	 Rules must be a minimum of .25 points.  
If less than .25 points they may appear correct on  
the proof, but may not print on press.

•	 Process colors should be defined as CMYK.  
All RGB, LAB, and Index colors must be converted to CMYK in 
the application’s color palette. Extra colors will be automatically 
converted to process or black/grayscale per the printer’s 
manufacturing work order.

•	 Trapping will be done at the printer. You are responsible for 
Overprint and Knockout settings.

GRAPHICS
•	 Screened graphics (CMYK, Grayscale, Duotone) should have 

an effective resolution of 300 dpi.

•	 Bitmap graphics (vector/line art) should have an effective 
resolution of 600 dpi.

•	 Graphics must be converted to CMYK or Grayscale.

•	 Duotones should be created in Photoshop,  
Quark XPress, or InDesign.

PAPER
Publication printed on 50-lb. enamel white stock. Paper  
stock subject to change depending on availability. Publisher  
is not responsible for reproduction quality when no color proof  
is provided.

ELECTRONIC FILE SUBMISSION
Files may be sent via e-mail or FTP. 
To utilize the FTP site, e-mail ftpsupport@nacs.org  
to request a user ID, password, and instructions. 
A color proof must be included with all submissions.  
A PDF for proof is preferred.

Preferred file submission:
High-Resolution PDFs  
(Refer to section on creating high-resolution PDFs.)

CREATING HIGH-RESOLUTION PDFS 
For accurate high-resolution PDFs, follow these steps. Zipped files are attached to this email.

If you have questions, please contact  

NACS at (800) 622-7498, ext. 2339.

InDesign
•	 Unzip and place this file on your hard drive. 
•	 Go to File > Adobe PDF Presets > Define.
•	 Click Load and navigate to the file on your hard drive.  

Select the file and click Done.
•	 To create a PDF, go to File > Adobe PDF Presets  

and select Walsworth_PressQuality_2013. Click Save.  
The settings are correct and no modifications are required.

Adobe Acrobat Preference Settings
•	 Unzip and place this file on your hard drive. 
•	 Follow the instructions in the PDF.

Quark XPress
•	 Unzip and place this file on your hard drive. 
•	 Follow the instructions in the PDF.
•	 The settings are correct and  

no modifications are required.

Adobe Illustrator
•	 Unzip and place this file on your hard drive. 
•	 Go to Edit > Adobe PDF Presets > Import.
•	 Navigate to the file on your hard drive.  

Select the file and click Okay.
•	 IMPORTANT: Go to Effect > Document Raster  

Effects Settings. Check Color Model: CMYK and 
Resolution: High (300 ppi). (An image of this dialogue 
box is included in the zipped file.)

•	 To create a PDF, go to File > Save As and select 
Format: PDF. Go to Adobe PDF Preset and select 
Walsworth_PressQuality_2013. Click Save PDF. The 
settings are correct and no modifications are required.

IMPORTANT

DO NOT USE THE DEFAULT SETTINGS 
WHEN CREATING HIGH-RESOLUTION PDFS. 
MOST SOFTWARE APPLICATIONS DO NOT 
USE THE PROPER SETTINGS AS DEFAULTS.
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NACS MEDIA PLANNER	 AD SIZE SPECIFICATIONS

Full Page No Bleed	 Full Page with Bleed Allowance of 0.125" (or p9)
Ad Size: 	 Trim Size: 8.5” x 10.875” (Document Setup Page Size)
7.5" x 10" 	 Bleed Size: 8.75” x 11.125”

1/3 Page Vertical	 1/3 Page Square	 1/2 Vertical	 1/2 Island	
Ad Size: 	 Ad Size: 	 Ad Size: 	 Ad Size: 	
2.3125" x 10"	 4.875" x 4.875"	 3.625" x 10"	 4.875” x 7.5625”	

1/2 Horizontal	 1/4 Page
Ad Size: 	 Ad Size: 
7.5" x 4.875"	 3.625" x 4.875"

2-Page Spread with Bleed Allowance of 0.125" (or p9)
2 Facing Pages, Size: 8.5" x 10.875" (Document Setup Page Size)
Bleed Size: 17.25" x 11.125"

Full-Page Ads with Bleed
•	 Page Size = 8.5" x 10.875"

•	 Bleed = 0.125" (or p9) 

•	 Crop and Registration Marks  
Offset = 0.125" (or p9) 

Crop and registration marks  
CANNOT be in the bleed area.

•	 Safety Margin = 0.1875" 

•	 Convert all colors to Process.
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N
o text in the gutter.

Important

1/2-Page Spread with Bleed Allowance of 0.125”  
(or p9) on left and right
Illustration shows 2 Facing Pages,  
Size: 8.5” x 10.875” (Document Setup Page Size)
Ad Size: 17” x 4.875”
Ad Bleed Size: 17.25” x 4.875"

1/2-Page Spread with Bleed Allowance of 0.125"   
(or p9) on left, right, and bottom
Illustration shows 2 Facing Pages,  
Size: 8.5" x 10.875" (Document Setup Page Size)
Ad Size: 17” x 5.5”
Ad Bleed Size: 17.25" x 5.625"
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NACS MEDIA PLANNER	 SPECIAL PRODUCT SECTIONS

NACS Cancellation Policy:
Cancellations of signed contracts will result 
in a $1,000 penalty fee and a recalculation of 
advertising rates if the contract was for multiple 
issues. Advertisers with multi-issue mid-contract 
cancellations will be charged for ads placed at 
the full rate and not the discount multi-issue rate.  
The full contract amount will also be billed if a 
signed contract is received, but the advertiser 
fails to submit artwork by the issue deadline.

PHOTO SUBMISSION
Photos may be sent via CD, 
ftp, or e-mail.

Photography needs to be 
a minimum of 5" x 7" wide 
at 300 dpi. 72 dpi files are 
accepted only if the image 
can be reduced to 33%  
and still be 5" x 7" wide.  
Tiff files are preferred; jpegs 
are accepted.

Please compress with WinZip 
or Stuffit.

PLEASE SEND THIS:
TEXT SUBMISSION
Please send a 50-word description of your 
product. The College Store reserves the right 
to edit submissions longer than 50 words.

Text may be sent via CD, ftp, or e-mail. 	
Microsoft Word documents or text submitted 

in the body of an e-mail are fine.

Birnn Chocolates of Vermont
	 Birnn Chocolates of Vermont introduces  
polka-dotted, twist wrapped caramel  
and raspberry truffles for the college  
market. As a back-to-school special,  
receive a free metal counter-top  
display ($60 value) with a case order.  
For more information, see postcard 
insert in magazine, call (800) 338-3141, 
or fax (802) 860-1256.

sample

sample

PLEASE DON’T SEND THIS:
Created advertisements 
where pictures are placed 
with styled text.

We will not use logos or other 
miscellaneous photos with the 
product photo.

Birnn 
Chocolates 
of Vermont
Birnn Chocolates of Vermont 
introduces polka-dotted, twist 
wrapped caramel and raspberry 
truffles for the college market.  
As a back-to-school special,  
receive a free metal counter-top 
display ($60 value) with a case 
order. For more information, 
see postcard insert in magazine,  
call (800) 338-3141, or  
fax (802) 860-1256.

sample

don’t send

SUBMISSION SPECS  
SPECIAL PRODUCT SECTIONS
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NACS MEDIA PLANNER	 CAMPUS MARKETPLACE

The Campus Marketplace weekly e-mail newsletter is the primary way NACS 

members obtain timely news about the collegiate retailing industry. Delivered 

on Fridays, Campus Marketplace articles offer industry news concerning retail 

and publishing issues and practical suggestions about collegiate retailing issues 

such as customer service, marketing, emerging technologies, legislation, and 

best management practices.

Advertising in Campus Marketplace places your company in readers’ inboxes 
every Friday, and allows readers to instantly access your web site for further 
details on your company, your products and services, and special promotions. 
Members rate Campus Marketplace a top benefit provided by NACS—
make sure they see you here!

ADVERTISEMENT 
LOCATION

DURATION* RATES**

Horizontal Top Tier 4 issues $1,600

Horizontal Middle Tier 4 issues $1,400

Horizontal Lower Tier 4 issues $1,000

Vertical Top Tier 4 issues $1,400

Vertical Middle Tier 4 issues $800

Vertical Lower Tier 4 issues $500

* Duration will be four consecutive issues.
** 30% additional charge for non-vendor affiliates.

PRODUCTION SPECIFICATIONS

Vertical	 120 pixels wide x 180 pixels tall

Horizontal	 410 pixels wide x 100 pixels tall

File Size	 50K maximum

Image File Format	 GIF or JPEG

Submit advertisements to: 	kgibbs@nacs.org

Advertisement must be submitted in electronic format. 

DEADLINE

Two weeks prior to scheduled ad placement.

CIRCULATION

6,000+
FREQUENCY

Weekly

Vertical Ad
Top Tier

120 x 180

Vertical Ad
Middle Tier
120 x 180

Vertical Ad
Lower Tier
120 x 180

Horizontal Ad
Top Tier

410 x 100

Horizontal Ad
Speciality Spot

410 x 100

Horizontal Ad
Middle Tier
410 x 100

Horizontal Ad
Lower Tier
410 x 100
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NACS MEDIA PLANNER	 VENDOR SPOTLIGHT EMAIL BLAST

Promote your business to the campus 
retail marketplace. Have your message 
sent directly to NACS Members’ 
inboxes. Email is the third most 
influential source of information for 
B2B audiences, behind only colleague 
recommendations, and industry-
specific thought leaders. 

SPECS: 606px wide x 690px high; 
72ppi; RGB

DEADLINE: one week prior to  
schedule email release.

RATE: $2,500

30% additional charge for non-vendor affiliates.

EMAIL 
ADDRESSES

3,000+

Put your product 
in front of your customers!
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NACS MEDIA PLANNER	

Promoting your company on  
NACS’ connect community page, 
The HUB, gives you access to 
our store members. 

NACS Cancellation Policy:

For digital and other advertising or sponsorships: Cancellations of signed contracts will result in a $1,000 penalty fee and a recalculation of advertising rates if the contract was for 

multiple advertisements or sponsorships. Advertisers with multi-issue mid-contract cancellations will be charged for ads placed at the full rate and not the discount multi-issue rate. 
The full contract amount will also be billed if a signed contract is received, but the advertiser fails to submit artwork by the issue deadline. 

http://thehub.nacs.org/home

ADVERTISEMENT DURATION RATES

A. Homepage Rotating Banner 1 month $1,600

B. Global Community Banner 1 month $1,400

C. Reply discussion and HUB email ad 1 month $1,000

PRODUCTION SPECIFICATIONS 
Advertisement must be submitted in electronic format and saved as 
72dpi, RGB, JPEG/PNG. Non-rotating ads preferred

A. Homepage Rotating Banner	 1200pixels wide x 250pixels tall 

B. Global Community Banner	 125pixels wide x 525pixels tall

C. Reply Discussion and Hub email ad	 125pixels wide x 125pixel tall 
  

Submit advertisements to: kgibbs@nacs.org 

Deadline: Two weeks prior to scheduled ad placement.

PAGEVIEWS

567,730

A.

B.

C.

30% additional charge for non-vendor affiliates.
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Conduct your own direct marketing campaigns with the help of NACS! We offer a large selection of buyer categories and 
list fields, so you can mail to the audience that’s precisely right for your product or service. The NACS database is updated 
daily, virtually eliminating wasted circulation. Electronic data is emailed to you.

I. STANDARD MAILING LIST:
	 �Mailing Lists include Contact Name, Store Name,  

Address, City, State, and ZIP.

A. Stores (choose one):
	 n NACS Members 
	 n NACS Members plus Prospective Members

B. Basic Fields (choose one):
	� Option 1: 
n �College Store Manager Name

	� Option 2: 
n �Department Buyer Name ONLY

	 n �Department Buyer Name—if Buyer name not 
available, provide Store Manager Name. 

    �When selecting a Department Buyer option, be  
sure to choose a specialty.

	 • Department Specialties:
	 	 n Course Books	 n Student Academic Supplies
		  n General Books	 n Health & Beauty Aids
		  n Computer Supplies	 n Softgoods
		  n Computer Software	 n Gifts
		  n Food	 n Greek Merchandise
		  n Health Science Books

C. �Additional Fields (extra fees apply):
	 • �Gross Sales (of NACS members only and only  

where available)
		  n �Under $100,000
		  n �$100,000 to $599,999
		  n �$600,000 to $999,999
		  n �$1M to $2,999,999 
		  n �$3M and over
		  n �Any college store over $1M

	 • �Store Ownership:
		  n �Institutional
		  n �Private
		  n ��Contract Managed (where available)

	 • �Other Fields:
		�  n �Selected States or Geographic Regions
		  n �Stores Serving 4-year Schools
		  n �Stores Serving 2-year Schools
		  n �Stores by Specific School Enrollment Category
		  n �Health Science Stores

D. Pricing:
Information is provided in Excel format.

NACS electronic data purchases are  
nonrefundable. Some are only available 
for purchase by NACS vendor affiliates.

Choose from:
	 n One-time Use Agreement     
	 n 3-month Use Agreement
	 n 12-month Use Agreement

One-time Use Pricing

	 • �NACS Members Item #3019	 Price: $440 
	 • �NACS Members plus Prospective Members 

Item #3020  Price: $660

3-month Use Pricing

	 • �NACS Members Item #5826	 Price: $585
  	 • �NACS Members plus Prospective Members 

Item #5827  Price: $795

12-month Use Pricing
	 • �NACS Members Item #2100	 Price: $1,750 
	 • �NACS Members plus Prospective Members 

Item #3021  Price: $2,390

Also Available:
	 • �Data Updates: $150 each (with 12-month  

agreement)*
	 • College Store Phone Numbers: add $265
	 • CASS Certification and NCOA: add $35

 NACS
VENDOR

AFFILIATES
ONLY
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II. ELECTRONIC DATA

A. �Database Licensing  
 ��(For sale exclusively to NACS  
vendor affiliates. Prepaid orders only.) 

Create your own reports, files, and mailing campaigns!  
Database licensing has allowed companies to better manage their  
sales territories, generate market analysis reports, and better focus  
and conduct their overall marketing efforts. 

The NACS database contains the information found primarily in  
the Directory of Colleges and Colleges Stores, and may include  
NACS store members and prospective store members. 

12-month Database Licensing
A. Basic Fields
Item #3003
NACS Members    
Price: $1,750
NACS members plus Prospective Members
Price: $2,390	

• Record ID #-referred to NACS #
• Contact Name for Store	
• Store Name			   		
• Address 1
• City				 
• State				  
• ZIP
• Country

 
B. Additional Fields (Choose from:)
Item #3036 
Price: $265 per additional field   
(Buy 4 additional fields and the 5th one is free!)

n  Phone					   
n  Fax				  
n  Institution Name				  
n  Institution City			 
n  Institution State			 
n  Store Ownership			 
n  Institution Type
n  Enrollment—Current year (Full-time/Part-time)	
n  Calendar Type—quarter/semester/trimester
n  School Controlled by—Church/State
n  SANS #
n  Percentage of Students in Dorms/Commuters
n  �Starting and Closing Dates for the Institution: winter  

break, spring break, commencement. (Subject to avail-
ability.)

n  Store Hours
n  Greek Life
n  School Colors
n  School Mascot	

Also Available:
Data Updates: $185 each*

ABOUT ALL  
ELECTRONIC DATA SALES:

All NACS electronic data purchases  
are nonrefundable. 

A license agreement must be signed,  
and payment must be made prior to  

release of the data.

*Where offered, data updates are only  
available within the terms of the agreement, 

and are formatted in accordance with the 
initial order. Updates may only be purchased 

within 10 months of the initial order. 

 NACS
VENDOR

AFFILIATES
ONLY
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Please allow a minimum of 7-10 working days for the processing of all lists.

Electronic data will be in Excel format, sent as an email attachment. Enter email address in the space provided below.

Please send the following electronic data:

n Mailing List (Choose One:)   n One-time Use Agreement      n 3-month Use Agreement       n 12-month Use 

Agreement 
n College and University Dates
n Database Licensing

Description	 Quantity	 Unit Price	 Total Price

		   Grand Total
                     	                                

Purchase Order Number_ __________________________________________ NACS Member Number_______________________________

Name_______________________________________________________________________________________________________________

Firm/Company________________________________________________________________________________________________________

Address_ ____________________________________________________________________________________________________________

City/State/ZIP_________________________________________________________________________________________________________

Phone___________________________________________________________ Email_______________________________________________

Signature*________________________________________________________ Date________________________________________________

*By choosing an electronic data option, a separate rental agreement will be sent to me to sign before the data is sent. I am also aware that decoys are included in all lists to 
monitor usage. I agree that violations of this agreement may be enforced by injunctions, and that damages may also be awarded if a court determines that is appropriate. 
Redistribution:  It is unlawful to resell or redistribute lists to any person or company, including but not limited to other members of the National Association of College 
Stores, any joint venture or buying group, without prior written permission from the National Association of College Stores.
Penalties:  Any unlawful copying, reproduction, and/or redistribution of lists will be prosecuted to the full extent of the law, including both civil and criminal penalties. 

 
Payment Options:
n  Please charge to my:     n  VISA      n  MasterCard     n  AMEX   

Card Number________________________________________ Expiration Date_______________________ Security Code_________________

Name as it appears on the card_ ________________________________________________________________________________________

Place your order today!
Contact NACS Advertising Sales


